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Units
AGT_Field allows you to change the East North order as well as angle and 
distance units as needed. This function is called automatically that AGT_Field is 
first run on a job. Under normal circumstances you would never need to run this 
option again. If you do you can run it from the Cogo - Units menu item.

Please note that we recommend that you do not change units within a job. (Note: 
screen shot below will change to add in EN order)

Angular Units may:

Degrees – 0 – 360 format ddd.mmss
Grads 0 – 400
Mills 0-6400
Quadrants format qdd.mmss where ‘q’ is the quadrant indicator – 
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1 is NE,  or  N 23.1345 E
2 is SE,  or   S 23.1323 E
3 is SW, or   S 24.5643 W
4 is NW or   N 27.1252 W

Distance units can be either Metres or Feet
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Introduction

This manual documents the installation procedure and lists the commands and 
procedures that AGT_Field supports.

We have some additional documentation that may be useful to get you acquainted 
with AGT_Field. There are two tutorials on our web site. The first shows you how 
to access some supplied data that is shipped and installed with AGT_Field. Please 
log onto our website http://www.gt-aust.com  /gtfield   .

Your device also has a help system. Click on the “Help” menu item.

Displaying the Menu and Hot Keys
AGT_Field displays a menu function optimised for the PDA screen. Traditional 
Windows CE menu's would sit along the bottom status bar and would display 

similarly to the windows desktop menu 
system. The problem being that the menu 
on the PDA is difficult to see due to the 
small real-estate, especially in direct 
sunlight. The AGT_Field menu fills the 
entire screen making it easier to see and to 
also select. The Archer2 will also bring up 
the menu item when hitting the “menu” 
hot key.  This is the key top right of the 
archer2 keyboard that consists of 4 
horizontal lines on top of each other. 
Alternatively selecting the “menu” item 
from the menu bar will bring up the full 
screen menu.

The following hot keys are supported:

• - key zooms in
• . key zooms out

AGT_Field also supports dynamic Pan. Press down on the screen and move your 
stylus/finger. The display will be panned.
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Display Controls

Before you start to work in earnest, you should acquaint yourself with the 
following commands that will allow you to control what is displayed on the screen.

Please note that only one attribute of a point can be displayed at any given time, 
and at the moment the ‘displayable’ attributes are Point Number, Height and Code.

Also note that the Layer facility is not implemented, and probably will not be in the 
near future due to the limited nature of the display on your handheld units. If you 
use Codes within AGT_Field then it is a simple matter in most desktop software to 
assign points to layers.

Pull down the Util menu and select the relevant attribute.

You can control how much of the job is displayed by using the Zoom facility.

You activate Zoom by using the ‘Util – Zoom’ options from the menu.

You can 
• (zoom window) drag your cursor to show the extents of the window you 

wish to display
• (zoom extents) shows whole job
• (zoom in) 
• (zoom out)

Please note that you can zoom in and out using the hot keys '-' and '.' on your 
numeric keypad.

A dynamic pan is also implemented. Click and drag to perform.

Photographs
AGT_Field allows the capture of photo's and they may be referenced on the screen.
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Photo's are associated with a point in the database. Photo's are stored in the same 
folder as the database (.ezi) file. If for example the jobname was called myjob then 

some typical photo names could be myjob_1.jpg and myjob_12.jpg. These photo's 
would be associated with points 1 and 12 respectively in the myjob database.

Photo's referenced with the job are shown with a red icon at each relevant point; as 
can be seen in the screen shot below: If you tap on one of the red icon's then the 
associated photo is displayed as seen at the right.

 

Entering a Photo
As already mentioned any photo's are associated with a point and have a specific 
file name based on the jobname and the point number. It is possible to pickup and 
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or calculate the points and then go back later and take / and or import some 
photographs and name them accordingly to associate the photo with the 
appropriate point. This may or may not be easy or relevant for what you do. We 
have automated the process to make it easier for the user.

There are a number of ways of getting the photo's integrated.

From the Point (Pt) menu select “Attach Photo”. Simply enter the appropriate point 
number and simply click on the “Take Photo” button. AGT_Field directs you to the 
“Pictures and Videos” application that ships with the device. Take the photo and 
click OK. If the picture displayed is not appropriate you can redo and the photo 
will be overwritten.

Alternatively from the Point menu tap on the “edit Pt” menu item. You can select 
the appropriate point and then click on the “Photo” button. Follow instructions 
above to take photo.

Photo's can also be taken as part of the procedure when picking up points using the 
GPS functions. 

When picking up GPS points there are two screen modes. You can pick points up 
using either a full screen dialog or a small modeless dialog where job plan is also 
visible.

In full dialog mode simply store a photo 
by pressing the “Photo” button. The appropriate point is stored and AGT_Field 
then prompts you to take the appropriate photo.
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If using the smaller dialog with plan view visible then firstly hit the “Store” button. 
Then click on the “Point” menu and then use the “Attach Photo” option as 
described above.

Entering a Photo when you can't access the point
If you wish to enter a photo and you can't physically access the point then you can 
use the appropriate Cogo routine. For example if you know the bearing and 
distance from a point then use the “Cogo” “Bearing and Distance” option to 
calculate the new point. You then attach the photo to the point as described above. 
Please remember for low accuracy GIS jobs or similar you can use the built in 
Compass to estimate the bearing. If you are using the Archer2 the compass is 
brought up from the:

Windows icon ->Settings -> System -> Sensors.

You can also use some of the Cogo intersection routines if necessary and then use 
the “Attach Photo” option. 
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Bitmap
AGT_Field can display a single or multiple bitmap/jpeg/tiff file's. To display a 
background file do the following. First copy the file or files needed for the 
background, and place them in a directory of my documents. We suggest the gtfield 
subfolder. If they already have an associated worldfile then copy it as well. The 
world file is an ascii file that goes with each bitmap to fix it's position. This ascii 
file has the same name as the jpeg but has a w on the end. This file was originally 
specified by ESRI; and a number of GIS packages will create these files for you.

An example file is

0.0000023 (longitudinal degrees per x pixel)
0.0
0.0             (rotation needs to be 0 for AGT_Field)
-0.00000214  (latitude decimal degrees per pixel)
151.313321   (longitude top left corner)
-32.442342   (latitude top left corner)

You can create these files manually if need be. However AGT_Field has a routine 
to help you georeference these files and will be explained shortly.

To select File/Files to display click on bitmap menu item. To select the file to use 
click on browse and click on the appropriate background file. If a world file is 
asociated with it then it is displayed in the bottom edit box. Make sure you click on 
the “Display Bitmap” to display. You can come back in and untick this if you don't 
need it displayed. Clicking the “Display Folder” displays all the appropriate jpeg 
files that are found in this directory. If you need to have different sets of 
background bitmaps then you will need to specify different folders for each set of 
files. If you select a single file and it has no world file then a dummy one is created 
so that the file is displayed in space somewhere.

Georeferencing a Background File
Do the following procedure:

1. open up a new job that is empty

2. Select a single background file

3. From util menu do zoom – extents
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4. Click on Georef  Bitmap menu item.

5. You need to single click two points in order on the screen.

6. You can use zoom in,zoom out and the pan keys to help select these points 
more accurately.

7. A dialog now comes up and you need to enter in the longitude and latitude 
respectively for these 2 points in decimal degree's. We have found Google 
Earth is handy here to get the lat,longs.

8. Press OK and then Zoom Extents.

Transferring Jobs To 
the Desktop

Data can be transferred from AGT_Field 
onto your desktop computer in a number 
of different formats. Raw data shots 
picked up from a Total Station; can be 
transferred by a raw SDR33 file. Reduced 
coordinates from a Total Station or GPS 
can be transferred by a SDR33 file or a 
CSV (Comma Separated Variables) which 
you can import into most desktop 
surveying programs or into Microsoft 
Excel.  

Transfer data this way by selecting the 
“File” menu item and then “Serial 

Transfer”. Select the serial port option and whether you want to send data as 
SDR33 raw SDR33 coords or CSV. Make sure your serial cable is connected and 
appropriate data collection / surveying software is running on your desktop.

Alternatively save the data to a file and transfer the data using the 
ActiveSync program to your desktop.

If you are running CDS software on your desktop then you can transfer the 
AGT_Field data file directly to your desktop and manipulate it in CDS. This can 
make life a whole lot easier for you, and it completely overcomes the traditional 
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problems associated with uploading and downloading to data collectors if it is used 
correctly.

Jobs in AGT_Field ‘jobname.ezi’.

If you wish to open an AGT_Field job with the Utilities, select File Open, and then 
pull down Files of Type and select the “AGT_Field (*.ezi)” option.

Transferring Jobs From Desktop

You can import raw data files into AGT_Field via the SDR2/SDR33 raw data 
format; as coordinates or alternatively AGT_Field will import a CSV file in the 
format “point number,north,east,reduced level,code”.

Most Surveying / Civil Engineering software will create the SDR2 file as well as a 
CSV file. Alternatively use Excel to create the CSV.

If you are running CDS  on your desktop then you can run existing CDS jobs in 
AGT_Field. In CDS on the desktop you should use File > Save As and then tick 
the box which says AGT_Field Data. Select OK, and you will find that a file called 
‘jobname.ezi will be stored for you to transfer to your Handheld.

So, for example if you have an CDS job called ‘detail1’ on your desktop computer 
you will find a file named ‘detail1.ezi’ which you can then store in the folder which 
is being synchronized with the handheld..

If you wish to take strings across from the desktop you will also need to copy 
across the file ‘detail.str’.
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File

When you access the File Menu the screen will appear as seen above, and each of 
the options is discussed below.

New
The New option will provide you with a new ‘blank job’ in which to work.

While the program is happy to work without having any job name assigned, we 
suggest that you get into the habit of saving the job and supplying a meaningful 
name as soon as you have added any worthwhile data..

You may use long job names if you wish, and any valid filename will be accepted. 
We suggest you confine yourself to letters and numbers to make up the job name, 
and while spaces are accepted, we would generally not encourage their use
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Open
Allows you to open existing AGT_Field  jobs. 

Once you select the relevant file you will see a series of ‘dots’ representing the 
points appear on the screen together with their point numbers.
Refer to Display Controls above for how to control the display.

Save
Once you have gathered any worthwhile amount of data we encourage you to use 
the Save function to save the data with a meaningful job name.

We also encourage you to use the Save option at regular intervals throughout the 
collection process.

Save As

Simply allows you to save an existing job with a new job name.

Simply type in the job name you wish to use and the convention of adding a suffix 
of ‘ezi’ will happen automatically.

Serial or File Transfer

To export coordinated points from AGT_Field; you can save the coordinated points 
into either a CSV (comma separated value) file, or a file in SDR format, both of 
which can be ready by most Survey & engineering software packages.

You may also choose to transfer all of the Raw field readings into a file in SDR 
format for import and processing into some other software such as Least Squares 
programs and the like.

You will be given the option of providing a name for the file, as well as using the 
normal windows browsing options to determine which folder the file will be stored 
in.
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GPS

The following is specific to the Juniper Archer2. If you are running a different 
device then the following may not be applicable.

The Archer2 Internal GPS uses COM8 at 115200 baud. You can use the GPS 
directly by setting the serial port in AGT_Field to Com8. However several devices 
can share the COM port setup for the GPS (com8) using the GPS Intermediate 
Driver (GPSID)

The GPS Intermediate Driver (GPSID) is used to allow more than one program to 
use data from the GPS receiver. The GPS Settings control panel controls how the 
GPSID is used. Internal GPS is on COM8 and communicates at 115200 baud. 
These settings are found on the Hardware screen of the GPS Settings control panel. 
If another GPS receiver is to be used, this is where you connect that GPS receiver 
so that the GPSID can access it.

The GPSID can output data on another COM port in a way that allows multiple 
programs to access the same COM port. This is called the Program Port and 
defaults to COM2. This can be set up on the Programs screen of the GPS 
Settings control panel.

The camera, GPS function and GPS compass function use the GPSID to obtain 
GPS information. If you use Com8 directly these additional functions will be 
disables. In particular camera geotagging will not be enabled.

We suggest you setup the GPS serial port using COM2.

AGT_Field can connect directly to the internal PDA GPS unit. As above we 
suggest you connect to COM2 via the GPSID driver. It is also capable of 
interfacing to an external GPS as long as it is capable of NMEA output. 
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The process consists of performing the following steps. Firstly AGT_Field needs to 
be set to match the serial configuration of the GPS we are connecting to. From the 
entry menu “ent” select the “Serial Configuration” entry and set the baud rate, 
parity and number of stop bits etc to match the GPS. For the Juniper Archer2 there 
is a default button that you can click to fill in values automatically to connect 
directly to internal GPS COM port.

This only needs to be done once. 
The values are saved for next time 
the routine is run. 

Also please note that there are 
options to set your local zone, for eg 
UTM, NAD27 etc. Find it under the 
pickup routine - full screen.

START/STOP  GPS

Clicking this button starts the GPS. 
If it is already running the GPS is 
stopped. 

As some GPS's can take time to lock 
on it is worthwhile starting the GPS 
as early as possible.  Once the GPS 
has a valid fix; it will display a cross 
hair cursor to show position. The 
screen is automatically panned so 
that the cursor is always visible.

This is a useful feature; especially in conjunction with a georeferenced background 
jpeg displayed.

Pickup
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A cross hair cursor is displayed when doing a pickup; for a visual display of your 
position.

This routine is used to extract data from the GPS unit and store if appropriate. You 
can run this routine with either a small modeless type dialog where data being 
picked up is visible, or alternatively  as a full screen dialog which contains more 
details. Clicking on this option brings up the following dialog. Dialog first appears 
in the minimized mode. Clicking on the More button toggles between minimized 
and maximized mode. The maximized mode contains extra information as shown 
below.

Once the dialog appears the first requirement is to change the antenna height; if the

 

height is required for your application. In this mode the height component is 
normally not accurate enough to be of use. To set the antenna height; first click the 
“Stop” button. This stops the dialog from being continually updated. Now enter the 
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Antenna Height into the A.H edit box. Click on the “Run” button to restart the 
GPS.

Once this dialog appears the GPS automatically starts up and this dialog shows the 
calculated Eastings and Northings. Please be aware that the acquisition times for 
some GPS can be in the minutes when first used so please be patient. Once GPS is 
downloading correct coordinates then we have the option of how the data is put 
into the database. We can set the data to be automatically input at a set time 
interval, a set distance or manually when we decide. This is initially setup in the 
setup option in AGT_Field.

If we have set the program for automatic entry then the data is automatically added 
in at the preset interval or preset distance from the previous entered point. 
Otherwise when you wish to add in the data press the store key. The point is added 
in to the database.

You may also code the points for future reference as they are added in. If you click 
into the Cde edit box then the predefined codes are displayed. Select the 
appropriate code or enter your own code manually using the PDA keyboard.

For greater feedback please press the “More” key. This displays a number of extra 
fields in the dialog box. The Latitude and Longitude are displayed in decimal 
degrees.  The #sat is the number of satellites used to determine the reading. The 
more satellites the better. Normally 4 or greater is acceptable. The next field is 
Hdop and stands for Horizontal Dilution of 
Position and it is a measure of how accurate 
the data is.  The value ranges from a 
minimum of 1.0 up to about 50. The smaller 
the number; the more accurate the answer. 
To gauge an idea of the error ellipse multiply 
the Hdop value by the expected greatest 
accuracy of the GPS. For example if your 
GPS is capable of accuracy’s of about 3 
meters and the HDOP value is 1.6 then 
expect an error of up to 3*1.6 = 4.8 meters.

The “Local Zone” button brings up a list of 
the zones that AGT_Field supports. For 
example UTM, AMG  and a number of US 
zones – eg CA zone3(27). If you need an 
additional zone implemented please contact 
us and we will include it. This drop down 
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box is also included in the initial GPS setup and you would normally select and 
change the zone at that point.

Set Out

A line is displayed from the present GPS 
position to the point we are staking to.

 This option enables one to find a predefined 
point. It reports Bearing and Distance, or 
optionally East and North from the present 
position as reported by the GPS to the pre-
defined position that is already defined within 
the database. This point could have been 
entered manually, calculated or picked up 
previously using GPS.

Chainage and Offset

This option reports the chainage (distance 
along) and the offset (perpendicular distance) 
from a string line defined in AGT_Field.

You first need to define a string. Please look at 
the Strings section of the manual.

First select the appropriate string to use. 
Initially select the folder using the drop down 
list in the folder combo box. Now select the 
string id from the drop down list in the Strings 
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combo box.

The dialog will now report the chainage and offset along the appropriate string. 
The data box reports the type of data being received. For example single , 
differential, RTK solution etc.

Commands

This option allows us to view the commands as they are received from the GPS. It 
is a good check that the GPS is indeed working.

Clicking on the “File” tick box copies all the GPS commands to a disk file.

Satellite Visual Info

The following dialog is displayed. The top 
row displays information received from the 
GPS and is a good visual indication if GPS is 
working. The current latitude and longitude 
are displayed. The value is in degrees and 
decimal minutes.

HDOP (horizontal displacement of position) 
and PDOP (perpendicular displacement of 
position) are shown; which gives a guide to 
the expected error values both horizontally 
and vertically. The Direction is shown as 
degrees from North and the speed is in knots. 
NMEA codes were originally designed for 
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nautical applications.

The visible satellites are displayed and the respective signal strengths are displayed 
across the bottom of the dialog.

Configure

Allows you to specify which brand and model of instrument you wish to interface 
to.

The options currently available are.

GPS
NMEA 

Code List
You can define a list of commonly used codes that you wish to have displayed on 
the screen as you collect data. You can then code any point by simply pointing to 
the relevant code from the displayed list.

At the moment, all the codes must be stored in a file named ‘road.fldcde’ in the 
gtfield folder on the Handheld.

← This file must contain One Code per line, and it MUST be stored in standard 
text format.
← Each code must be no more than 8 characters and we recommend that you do 
not use spaces within codes.

You can either create or edit this file using Pocket Word on your HPC.

If you attempt to open the default file that comes with AGT_Field, Pocket word 
will complain that it does not understand the format. Simply open it as a Text file.
When you save the file make sure that you also save it in Text format.
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Serial Configuration

Since there is no such thing as a ‘standard’ in the world of communications, much 
less Survey Instruments, this option allows you to configure the serial 
communications parameters to work with your particular  GPS.

The settings shown are the defaults for the Archer2.

Please note that in many instruments you can alter the settings on the instrument, 
and in that case it does not particularly matter what settings you have on the 
instrument providing you set EXACTLY the same settings on the mobile device.

The Nikon C-100 is not configurable on the instrument, and operates at 4800 Baud, 
No Parity, 8 Data Bits and 1 Stop Bit, so you will need to set your HPC to match 
these settings.
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Points

Allows you to Add and Edit/Delete points and obtain the bearing and distance 
between two existing points.

Add

Brings up a series of fields where you can type in the relevant coordinates and 
other information of points you wish to add into a job.
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Edit

Brings up a series of fields where you can type in the relevant coordinates and 
other information of points already in the database that you wish to change.

You can also remove or delete the current point by selecting the Remove button.

BE WARNED – think before you remove as there is currently no ‘OOPS’ facility.

Join – Inverse

The ‘connection’ between two points in the job is called an Inverse in the USA and 
occasional other places, and a Join in many other locations.

Whatever you choose to call it you can access the function from the Points menu, 
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or by pressing Alt J on the keyboard.

To select the points you can either type in the number or select the point by single 
tapping the point on the screen.
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Strings

Add

A “string’ in AGT_Field terminology is 
simply a line joining two or more points. If 
you are used to CAD terminology, a string 
is equivalent to a polyline.

You can add in strings between existing 
points with this option.

You must supply a valid String ID.

Then you simply list each of the point 
numbers separated by a comma.

Note that you can automatically create 
strings as you collect points by checking 
the ‘String’ box on the Survey screen.

Traverse Adjustment
You can select any string in the job by picking it from the Pull Down list.
Click the Misclose button to see the bearing and distance of the current misclose, 
and the relative accuracy.

If you wish to adjust the particular string to form a perfect close, you can choose 
either Transit or Bowditch and the coordinates of all points in the
string will be adjusted accordingly to provide a perfect close. 

Area
You can select any string in the job by first picking the folder from the pull down 
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list and then selecting the strings from it’s respective pull down list.

Click the Show button and the Area and Perimeter are shown. If the string is not 
closed then the area is shown as 0.000

COGO

The Cogo Menu will present the options as seen in the following screen, and each 
of these options is described below.

Bearing & Distance
Allows you to calculate new points by specifying their bearing and distance form 
an existing point.

This facility works in ‘traverse mode’ so the point you calculate becomes the next 
‘from’ point.

If you wish to calculate multiple points along a single bearing you can do so by 
entering the number of points you require into the ‘Multiple’ field.

If you wish to swing the azimuth, such as the case when working from old plans, 
you can type the correction required in the ‘Azimuth’ field, and the correction will 
be applied to the bearing you enter.

Radiate
Allows you to calculate new points by specifying their bearing and distance from 
an existing point.

Unlike the Bearing and Distance routine above, here all points are calculated from 
the one ‘from’ point.

Intersection

This routine allows you to specify two existing points, and the bearing from each 
of them, and it will calculate and store the new point where the two bearings 
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intersect.
The sketch below illustrates its function and the remainder or its operation is self-
explanatory

2 Distance Intersection

Here you can specify two existing Points, and a distance from each of them. 

If the distances you have specified do intersect, the program will draw circles with 
the respective radii you have entered around each of the points.

Where these circles intersect provide the two possible solutions as seen in the 
sketch.

Use the ‘Pnt Set’ pull down to highlight whether you require Pnt1 or Pnt2, and 
select the Apply button, and the new point will be added into the database.

Bearing & Distance Intersection
In this option you can intersect a bearing through one point with a distance from 
another point.
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The program will display the two possible solutions and you can choose the point 
that suits your needs.

Use the ‘Pnt Set’ pull down to highlight whether you require Pnt1 or Pnt2, and 
select the Apply button, and the new point will be added into the database

Offset Calcs

Chainage & Offset
The Offset Calcs allow you to either create cross section type information, or to 
input field surveys done in the traditional method of establishing a baseline and 
then locating detail points by distance along that line (Chainage) and the distance 
from that line (Offset)

This allows you to calculate points by specifying their chainage and offset relative 
to either a line between two points, or a line on a given bearing /azimuth through a 
particular point.

If you are using Points, you need to type in the Point numbers for Point 1 and 
Point 2.

If you are using Bearing, you need to enter the point number of Point 1 and then 
type in the bearing through that point.

You then enter the Chainage from Point 1 and the offset to the line of the new point 
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you wish to calculate, and press the Apply button.

New Point - you will be shown the next available Point Number. Remember that it 
often assists later identification if you ‘group’ points by starting new ranges on 
even hundreds or even thousands.

Parallel Offset
Refer to the sketch at right to see how this routine operates.
You need to specify 2 points, the bearings through those points, and the respective 
offsets to the bearings and the program will calculate and store the resulting point 
for you
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Pt 3 Calc'ed

Road Calcs

Parallel Offset
The purpose of this routine is to calculate a series of points on an alignment that is 
parallel to, and offset from an existing series of points.

Each of the new points is calculated on the half angle 

If you refer to the sketch below, you will see that points 1,2,3,4,5 make up an 
existing alignment.
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AGT_Field

It is our intention to create a line offset 20 metres to the left of the existing line and 
parallel to it.

When you enter the routine a dialogue box will appear and the first two items you 
strike are check boxes for the First Offset Point and Last Offset Point.

The First point is 6 on the sketch, while the last point is 10.

If you wish to have them calculated check the boxes.

You will then see a field for New point, and the next available Point Number will 
be displayed.
The process consists of calculating the offset at each ‘bend’ by entering 3 points 
with the middle point being the ‘bend’ 

It differs from the earlier routine named parallel offsets in that this one uses the 
half angle at the bend while the previous routine only uses a perpendicular to a line 
to calculate the offset.

Simply enter in the relevant points and their respective widths or offsets, which in 
this case would be -20 to indicate 20 metres to the left.

Then choose the OK button, and the points will be calculated and stored.
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